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SCXI-1104-C 32-Channel Medium Voltage Input Module

Product Information:

The SCXI-1104/C signal conditioning module is a product by
National Instruments. It requires the NI-DAQmx driver for
calibration. The module supports various programming languages
including LabVIEW, LabWindowsTM/CVITM, C/C++, C#, and Visual Basic
.NET. It is recommended to refer to the SCXI-1104/C User Manual for
more detailed information about the product. The calibration
interval should be determined based on the measurement accuracy
requirements of your application, with at least one complete
calibration recommended per year.

Product Usage Instructions:

1. Ensure that you have the latest version of the NI-DAQmx driver

installed on your system.

2. Refer to the SCXI-1104/C User Manual for detailed instructions

on how to configure and use the module.

3. Perform the initial setup by configuring the SCXI-1104/C for

calibration.

4. Proceed with the verification procedure to check if the

SCXI-1104/C is operating within its test limits.

5. Use the recommended test equipment listed in Table 1, or select

suitable substitutes based on the requirements provided.

6. Follow the calibration process steps as outlined in the user

manual to calibrate the SCXI-1104/C.

7. Repeat the calibration process at regular intervals based on
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the measurement accuracy requirements of your application.

8. Note that the default password for password-protected

operations is “NI”.

COMPREHENSIVE SERVICES

We offer competitive repair and calibration services, as well as easily accessible documentation and free
downloadable resources.

SELL YOUR SURPLUS

We buy new, used, decommissioned, and surplus parts from every NI series.
We work out the best solution to suit your individual needs.

 Sell For Cash     Get Credit     Receive a Trade-In Deal

OBSOLETE NI HARDWARE IN STOCK & READY TO SHIP

We stock New, New Surplus, Refurbished,  and Reconditioned NI Hardware.

Bridging the gap between the manufacturer and your legacy test system.

 1-800-915-6216

www.apexwaves.com

sales@apexwaves.com

All trademarks, brands, and brand names are the property of their respective owners.

Request a Quote    SCXI-1104

CALIBRATION PROCEDURE

SCXI™-1104/C

For NI-DAQmx

This document contains information and instructions for calibrating the National Instruments SCXI-1104/C signal
conditioning module.

Conventions
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The following conventions are used in this document:

»                        The » symbol leads you through nested menu items and dialog box options to a final action. The
sequence File»Page Setup»Options directs you to pull down the File menu, select the Page Setup item, and
select Options from the last dialog box.

                This icon denotes a note, which alerts you to important information.

bold                 Bold text denotes items that you must select or click in the software, such as menu items and
dialog box options. Bold text also denotes parameter names.

italic                  Italic text denotes variables, emphasis, a cross-reference, or an introduction to a key concept.
Italic text also denotes text that is a placeholder for a word or value that you must supply.

monospace       Text in this font denotes text or characters that you should enter from the keyboard, sections of
code, programming examples, and syntax examples. This font is also used for the proper names of disk drives,
paths, directories, programs, subprograms, subroutines, device names, functions, operations, variables,
filenames, and extensions.

monospace italic    Italic text in this font denotes text that is a placeholder for a word or value that you must supply.

Software

The SCXI-1104/C calibration procedure requires the NI-DAQmx driver. NI recommends using the latest driver that
supports both your development environment and the SCXI-1104/C. NI-DAQmx includes high-level function calls
to simplify the task of writing software to calibrate devices. NI-DAQmx supports many programming languages,
including LabVIEW, LabWindows™/CVI™, C/C++, C#, and Visual Basic .NET.

Documentation

The following documents are the primary references for writing your calibration utility:

The NI-DAQmx Help includes information about creating applications that use NI-DAQmx.

The NI-DAQmx C Reference Help includes information about the functions in NI-DAQmx.

The DAQ Getting Started guides include information about installing and configuring NI-DAQmx devices.

You can access these documents by selecting Start»All Programs»National Instruments»NI-DAQmx after
installing NI-DAQmx.

For more information about the SCXI-1104/C, refer to the SCXI-1104/C User Manual. For information about
installing and configuring SCXI modules, refer to the SCXI Quick Start Guide.

Calibration Interval



Calibrate the SCXI-1104/C at a regular interval as defined by the measurement accuracy requirements of your
application. NI recommends that you perform a complete calibration at least once every year. You can shorten this
interval based on the accuracy requirements of your application.

Password

The default password for password-protected operations is NI.

Test Equipment

NI recommends that you use the equipment in Table 1 to calibrate the SCXI-1104/C. If these instruments are not
available, use the requirements listed in Table 1 to select a suitable substitute.

Table 1. Test Equipment

Equipment Recommended Model Requirements

Calibrator Fluke 5700A 50 ppm

DAQ Device NI 6281 16-bit minimum

DMM NI 4070 6 1/2 digit, 15 ppm

Terminal Block SCXI-1300 —

          Note  A complete SCXI-1104/C calibration system is illustrated in Figure 1 with a listing of all the
components required for calibrating the SCXI-1104/C.

Test Conditions

Follow these guidelines to optimize the connections and the environment during calibration:



Keep connections to the SCXI-1104/C as short as possible. Long cables and wires can act as antennas,

picking up extra noise and thermal offsets that affect measurements.

Use shielded copper wire for all cable connections to the SCXI-1104/C. Use twisted-pair wire to eliminate noise

and thermal offsets.

Maintain the ambient temperature between 18 °C and 28 °C.

Keep relative humidity below 80%.

Allow a warm-up time of at least 15 minutes for the SCXI-1104/C and 30 minutes for the DAQ device to ensure

that the measurement circuitry is at a stable operating temperature.

Calibration Process

The calibration process has the following steps:

1. Initial Setup—Configure the SCXI-1104/C for calibration.

2. Verification Procedure—Verify the existing operation of the SCXI-1104/C. This step determines whether the

SCXI-1104/C is operating within its test limits.

3. Adjustment Procedure—Perform an external calibration that adjusts the SCXI-1104/C calibration constants

with respect to a known voltage source.

4. Verifying Adjusted Values—Perform another verification to ensure that the SCXI-1104/C is operating within its

test limits after adjustments.

Initial Setup

Complete the following steps to configure the SCXI-1104/C for calibration:

1. Make sure that all the appropriate driver and application software is installed.
2. Make sure all components involved in the calibration procedure are powered off.
3. Assemble the SCXI-1104/C, SCXI chassis, terminal blocks, and DAQ device as shown in Figure 1. You must
cable the SCXI-1104/C directly to the DAQ device. Install the SCXI-1104/C module in slot 1 of the SCXI chassis.



1  SCXI-1300 Terminal Block
2  SCXI-1104/C Module
3  SCXI Chassis
4  SCXI-1349 Cable Adapter

5  Shielded 68-Pin Cable
6  NB1 Cable (50-Pin Ribbon Cable)
7  CB-50 Connector Block
8  Cable to DMM

9   Cable to Calibrator
10  Calibrator
11  DMM
12  DAQ Device

Figure 1. Calibration Components and Connections

4. Power on the SCXI chassis and the external computer.
5. You must configure the hardware properly with Measurement & Automation Explorer (MAX). Refer to the SCXI
Quick Start Guide for details about configuring the SCXI chassis.

          Note  When you configure a device in MAX, the device is assigned a device identifier. In this
calibration document, the functions used for demonstrating the calibration process use the device identifiers Dev1
for the DAQ device and SC1Mod1 for the SCXI-1104/C. If you have more devices in your setup, use MAX to
identify your DAQ device name.

Verification Procedure

The verification procedure determines how well the SCXI-1104/C is meeting its test limits. You can use this
information to select the appropriate calibration interval for your application.

The SCXI-1104/C stores gain and offset calibration constants for each gain setting per analog input channel. A
complete verification of the inputs involves measuring the accuracy at all possible gain settings on all channels of
the SCXI-1104/C.

To view the calibration VIs in LabVIEW, select Measurement I/O»DAQmx – Data Acquisition»DAQmx
Advanced»DAQmx Calibration on the Functions palette. You can also use the Search button, shown in Figure



2, to look for a specific VI.

Figure 2. DAQmx Calibration Palette and the Search Button

Complete the following steps to verify the accuracy of each SCXI-1104/C analog input channel:

1. Use the DAQmx Self Calibrate VI to verify the DAQ device. This VI measures the onboard reference voltage of
the DAQ device and adjusts the self-calibration constants to account for any errors caused by short-term
fluctuations in the operating environment.

          Note  Throughout the verification procedure, refer to the function call parameters for the LabVIEW
input values.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxSelfCal with the following parameter:
Device_Name: “Dev1”

2. Connect the calibrator output to pins CH- and CH+ for all channels. Refer to the SCXI-1300/1301 Terminal
Block Installation Guide for connection instructions. If you are not using the recommended SCXI-1300, refer to
Table 4 for the front signal pin assignments of the SCXI-1104/C. If the calibration signal source is floating, connect
CH – to the SCXI chassis ground using the ground lug available on the SCXI terminal block.
3. Set the calibrator voltage to the desired test point indicated in Table 3.
4. Create a task using DAQmxCreateTask.



LabVIEW Block Diagram NI-DAQmx Function Call

LabVIEW does not require this step.
Call DAQmxCreateTask with the following parameters:
taskName: “AIVerificationTask”
taskHandle: &taskHandle

5. Add a voltage channel using the DAQmx Create Virtual Channel VI.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCreateAIVoltageChan with the following parameters:
taskHandle: taskHandle
physicalChannel: “SC1Mod1/aiX”†
nameToAssignToChannel: “myVoltageChannel”
terminalConfig: DAQmx_Val_Cfg_Default
minVal: -45 V
maxVal: 45 V
units: DAQmx_Val_Volts
customScaleName: ” “†Where X refers to the channel you are verify
ing.

6. Configure timing for the voltage acquisition using the DAQmx Timing VI.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCfgSampClkTiming with the following parameters:
taskHandle: taskHandle
source: ” ”
rate: 1000.0
activeEdge: DAQmx_Val_Rising
sampleMode: DAQmx_Val_FiniteSamps
sampsPerChan: 1000

7. Commit the verification changes using the DAQmx Control Task VI.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxTaskControl with the following parameters:
taskHandle: taskHandle
action: DAQmx_Val_Task_Commit

8. For each new test point, use the Time Delay Express VI to account for the settling time of the SCXI-1104/C.



LabVIEW Block Diagram NI-DAQmx Function Call

Call a sleep or wait function to suspend execution for 350 ms.

9. Acquire 1000 points of voltage data using the Analog 1D DBL 1Chan NSamp instance of the DAQmx Read VI.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxReadAnalogF64 with the following parameters:
taskHandle: taskHandle
numSampsPerChan: -1
timeout: 10.0
fillMode: DAQmx_Val_GroupByChannel
readArray: data
arraySizeInSamples: 1000
sampsPerChanRead: &read
reserved: NULL

10. Compute the mean of the 1000 voltage values that you acquired.
11. Compare the resulting average to the upper and lower limits listed in Table 3. If the result is between the upper
and lower limits, the SCXI-1104/C passes the test.
12. Clear the acquisition using the DAQmx Clear Task VI.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxClearTask with the following parameter:
taskHandle: taskHandle

13. Repeat steps 4 through 12 for the remaining channels.
14. Repeat steps 3 through 13 for all test points in Tables 3.

You have finished verifying the analog input accuracy of the SCXI-1104/C.

Adjustment Procedure

The adjustment procedure adjusts the gain and offset calibration constants on the SCXI-1104/C. Complete the
Verification Procedure prior to the adjustment procedure to determine the pre-calibration accuracy and whether
adjustments are necessary.

Complete the following steps to adjust the gain and offset of the SCXI-1104/C:

1. Connect the calibrator output to pins CH- and CH+ for all channels. Refer to the SCXI-1300/1301 Terminal
Block Installation Guide for connection instructions. If you are not using the recommended SCXI-1300, refer to



Table 4 for the front signal pin assignments of the SCXI-1104/C. If the calibration signal source is floating, connect
CH- to the SCXI chassis ground using the ground lug available on the SCXI terminal block.
2. Connect the DMM to MCH0+ and MCH0- (pin 3 and 4) on the rear connector. Refer to Table 5 for the rear
signal pin assignments of the SCXI-1104/C.

          Note  You can access these pins using a 50-pin cable connected to an SCXI-1349.

3. Start an external calibration session using the DAQmx Initialize External Calibration VI.

          Note  Throughout the adjustment procedure, refer to the function call parameters for the LabVIEW
input values.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxInitExtCal with the following parameters:
deviceName: “SC1Mod1”
password: “NI”
calHandle: &calHandle

4. Set the SCXI-1104/C to a physical channel using the DAQmx Setup SCXI Calibration VI.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxSetup1104Cal with the following parameters:
calHandle: calHandle
channel: “SC1Mod1/aiX”††Where X refers to the channel you are c
alibrating.

5. Set the calibrator to the desired voltage. Refer to Table 2 for appropriate voltage set points.

Table 2. SCXI-1104/C Voltage Set Points

Gain Set Points (V) 

0.1 -41.80000 0.0000 41.8000

6. Wait for 350 ms of settling time to elapse and then record the measured output from the DMM.
7. Adjust the external calibration constants using the DAQmx Adjust SCXI Calibration VI.



LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxAdjust1104Cal with the following parameters:
calHandle: calHandle
refVoltage: (calibrator output voltage) float64
measOutput: (voltage measured by DMM) float64

8. Repeat steps 5 through 7 for the voltage test points in Table 2.
9. Commit the calibration changes you made in the session using the DAQmx Close External Calibration VI. The
data is written to the hardware in this step.

LabVIEW Block Diagram NI-DAQmx Function Call

Call DAQmxCloseExtCal with the following parameters:
calHandle: calHandle
action: DAQmx_Val_Action_Commit

10. Repeat steps 1 through 9 for the remaining channels.

You have finished adjusting the gain and offset of the SCXI-1104/C.

Verifying Adjusted Values

After calibrating the SCXI-1104/C, NI recommends that you verify the analog input operation by repeating the
steps listed in the Verification Procedure to ensure that the SCXI-1104/C is operating within its test limits.

Test Limits

Refer to the SCXI-1104/C User Manual for the specifications of the SCXI-1104/C.

Gain and Offset

Table 3 contains the test limits to use when verifying and adjusting the gain and offset of the SCXI-1104/C. If the
SCXI-1104/C was calibrated within the last year, the test point value should fall between the Lower Limit and
Upper Limit values found in Table 3.

          Note  The values in Table 3 do not include DAQ device errors.

Table 3. SCXI-1104/C Test Limits



Gain Test Point (V) Upper Limit (V) Lower Limit (V)

0.1

41.800000 41.823536 41.776464

0.000000 0.006816 -0.006816

-41.800000 -41.776464 -41.823536

SCXI-1104/C Front and Rear Panel Diagrams

Table 4 shows the pin assignments for the SCXI-1104/C front panel connector. Table 5 shows the pin assignments
for the SCXI-1104/C rear signal connector.

Table 4. Front Signal Pin Assignments

Front Connector Diagram Pin Number Column A Column B Column C

32 CH GND CH 0- CH 0+

31 NC CH 1- CH 1+

30 NC CH 2- CH 2+

29 NC CH 3- CH 3+

28 NC CH 4- CH 4+

27 NC CH 5- CH 5+

26 NC CH 6- CH 6+

25 NC CH 7- CH 7+



NC—No Connection
RSVD—Reserved

24 CH GND CH 8- CH 8+

23 NC CH 9- CH 9+

22 NC CH 10- CH 10+

21 NC CH 11- CH 11+

20 NC CH 12- CH 12+

19 NC CH 13- CH 13+

18 NC CH 14- CH 14+

17 NC CH 15- CH 15+

16 CH GND CH 16- CH 16+

15 NC CH 17- CH 17+

14 NC CH 18- CH 18+

13 NC CH 19- CH 19+

12 NC CH 20- CH 20+

11 NC CH 21- CH 21+

10 NC CH 22- CH 22+

9 NC CH 23- CH 23+

8 NC CH 24- CH 24+



7 NC CH 25- CH 25+

6 NC CH 26- CH 26+

5 CH GND CH 27- CH 27+

4 RSVD CH 28- CH 28+

3 RSVD CH 29- CH 29+

2 CH GND CH 30- CH 30+

1 +5 V CH 31- CH 31+

Table 5. Rear Signal Pin Assignments



Rear Connector Diagram Signal Name Pin Number Pin Number Signal Name

NC—No Connection

RSVD—Reserved

AO GND 1 2 AO GND

MCH 0+ 3 4 MCH 0-

NC 5 6 NC

NC 7 8 NC

NC 9 10 NC

NC 11 12 NC

NC 13 14 NC

NC 15 16 NC

NC 17 18 NC

OUT REF 19 20 NC

NC 21 22 NC

NC 23 24 D GND

SER DAT IN 25 26 SER DAT OUT

DAQ D*/A 27 28 NC

SLOT 0 SEL* 29 30 NC

D GND 31 32 NC

NC 33 34 NC

NC 35 36 SCANCLK

SER CLK 37 38 NC

NC 39 40 NC

NC 41 42 NC

RSVD 43 44 NC

NC 45 46 RSVD

NC 47 48 NC

NC 49 50 NC
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World Wide Support and Services

The National Instruments website is your complete resource for technical support. At ni.com/support you have
access to everything from troubleshooting and application development self-help resources to email and phone
assistance from NI Application Engineers.

http://ni.com
http://ni.com/support


Visit ni.com/services for NI Factory Installation Services, repairs, extended warranty, and other services.

Visit ni.com/register to register your National Instruments product. Product registration facilitates technical
support and ensures that you receive important information updates from NI.

National Instruments corporate headquarters is located at 11500 North Mopac Expressway, Austin, Texas, 78759-
3504. National Instruments also has offices located around the world. For telephone support in the United States,
create your service request at ni.com/support or dial 1 866 ASK MYNI (275 6964). For telephone support
outside the United States, visit the Worldwide Offices section of ni.com/niglobal to access the branch office
websites, which provide up-to-date contact information, support phone numbers, email addresses, and current
events.

© National Instruments              SCXI-1104/C Calibration Procedure

Refer to the NI Trademarks and Logo Guidelines at ni.com/trademarks for more information on National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade names of
their respective companies. For patents covering National Instruments products/technology, refer to the
appropriate location: Help»Patents in your software, the patents.txt file on your media, or the National
Instruments Patents Notice at ni.com/patents. You can find information about end-user license agreements
(EULAs) and third-party legal notices in the readme file for your NI product. Refer to the Export Compliance
Information at ni.com/legal/export-compliance for the National Instruments global trade compliance policy and
how to obtain relevant HTS codes, ECCNs, and other import/export data. NI MAKES NO EXPRESS OR IMPLIED
WARRANTIES AS TO THE ACCURACY OF THE INFORMATION CONTAINED HEREIN AND SHALL NOT BE
LIABLE FOR ANY ERRORS. U.S. Government Customers: The data contained in this manual was developed at
private expense and is subject to the applicable limited rights and restricted data rights as set forth in FAR 52.227-
14, DFAR 252.227-7014, and DFAR 252.227-7015.

© 2000-2015 National Instruments. All rights reserved.       370267B-01       Jun15
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